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Sure, you can write…  
…but can you write with impact and leave behind the 

mistakes others make so often? 
 

In this special report, we’ve collected the best of 
Business Management Daily’s advice on writing for 

real impact and then presenting it with flair. 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 

7 tips to strengthen your writing  
 

Much of our workday is spent in communication with others. Make sure your 
writing doesn’t distract readers and cancel out your efforts to communicate 
clearly. Here are four rules to help improve your writing: 

1. Organize your thoughts to flow logically. Before your pen touches paper (or 
your fingers touch the keyboard), spend a few minutes thinking about the key 
points you want to make in your document. Ensure that you put your main point 
in your first statement or in the subject line of an email, rather than making the 
reader wade through lines of information to get to the bottom line. 

2. Use plain language. Never use two or three long words when one word will 
do. In place of phrases like “in the event that,” use a simpler word such as “if.” 
Write the way you talk rather than writing to impress. If you were speaking, 
would you really say, “Mary’s desk is in close proximity to mine” or “Mary’s desk 
is too close to mine”? Aim for this kind of simplicity in your written work. 

3. Write in active voice. Instead of writing, “The choice of location for the next 
annual meeting falls under the auspices of this committee,” make it clearer by 
writing, “Our committee will choose the location for the next annual meeting.” 
Unless you have some reason for obscuring who is responsible for a particular 
action, put that information at the beginning of a statement. 

4. Forget the jargon. It’s easy to fall into the habit of using important-sounding 
terms like synergize, impactful and mission-critical, but they don’t really mean 
anything. Stick with legitimate, clear words that get your point across. 

5. Use fewer words. Beginning writers often think that using a lot of words 
makes them sound knowledgeable, but it really just obscures what they’re trying 
to communicate. For example, “despite the fact that” can simply be changed to 
“although.” 
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6. Use more contractions. Many business writers make their documents sound 
unnecessarily formal by refusing to use contractions. Adopting a less formal tone 
will make your document a little easier for the reader to follow. Try using lots of 
contractions in the first draft of your documents and see how it sounds. If the tone 
seems a little too casual, change some of the contractions back to their complete 
form. 

7.Break the rules once in a while. Following all the rules religiously will give 
you 100% correct writing, but it will probably kill your voice—the little verbal 
quirks that make your writing sound like you. Don’t get sloppy, but if something 
just doesn’t sound right when you write it, consider bending a rule to make your 
writing sound more authentic. 

 
 

 Microsoft Word: Get the picture?  
 

Diagrams, pictures, charts and graphs can clarify your message, support your case 
and help visual learners to understand the information. Here is how to get them 
in there, make them look crisp and clear, and get them to stay put. 

Inserting images 101 

To get a picture into your document, on the Insert tab, in the Illustrations group, 
click the type of graphic you’d like to add. The hardest part of this process is to let 
go of where you’d ultimately like to see it, how big or small it should be, and how 
it should behave with the other content in your document. Just get it in there. 
Once you do, you will see dots around the image, which will allow you to resize it. 
Handle carefully! 

Tips for success 

If you take a smaller image and stretch it out with the handles, it’s the same as 
stretching stretchy fabric. It thins out and becomes less opaque. That might be OK 
with stockings, but not so much with your photos. Stretching it out will make it 
look fuzzy and out of focus. Use the largest, highest-quality image you can get and 
size it down to avoid diminishing the appearance of your image in the document. 
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Positioning and wrapping 

You will also see an upside-down horseshoe symbol on the side of the image 
you’ve inserted. This is the Layout Options button. It is the decisions you will 
make on the Layout Options button that will determine how your image behaves 
with text, whether it moves with text or occupies a fixed position on the page. The 
default is In Line with Text. Here’s what each option means and how they affect 
the way your documents appear in both Word desktop apps and Word online. 

In Line with Text: If you imagine that the first character of a word wasn’t a letter, 
but a picture, you’ll understand how this one works. Wherever this picture is 
inserted, it becomes part of the text it is in front of or behind, depending on where 
your cursor was. As you drag it, you’ll notice it doesn’t seem to come with you, but 
your cursor appears to move. It is marking the position where you want to move 
it. This option causes the image to behave the same in both the desktop and 
online versions of Word. 

Text Wrapping: All text-wrapping options also come with the options to have the 
image move with the text or be in a fixed position on the page. The default is that 
it moves with the text. This is where it gets a little messy between the desktop 
and online versions. Notice the white space in the rightmost split image? That’s 
the online version of the same document you’re looking at on the left presented in 
the desktop version. 

Tips for success 

If your document may be viewed in either app, Word desktop or Word online, it is 
best to use In Line with Text with a new paragraph both before and after the 
image. Work with the Show/Hide button on to see the position of paragraph 
markers (¶). The button looks like a paragraph marker and is located in the 
Paragraph group on the Home tab. Right, left and center alignment will all work 
as expected in both versions now. 

Neither text boxes nor tables with images inserted will get you around these 
issues. That said, if you want to insert multiple images side by side, a table makes 
it easy. Just remove the borders. While you will still see a thin gray line in the 
desktop app, the borders will be invisible in the online app. 

 

 



MS Word tip: Paste problems 
  

Collaboration is great! But, you may end up with 10 documents to combine into 
one, while everyone has approached formatting differently. One way to handle 
this is to copy and paste all content into one document and follow the steps 
explained above (under “Formatting Disagreement”). Another is a bit more 
surgical. When you copy and paste text from one document to another, you will 
see a pop-up control options box. Select the capital A. That just pastes the text, 
which inherits the surrounding formatting. 

 

 Keep it simple  
 

Turn business-speak into plain English by keeping your writing simple and to the 
point. Examples:  

Instead of:                 Use:  

activate                      begin  

advise                        tell  

along the lines of       like  

cancel out                 cancel  

demonstrate              show  

discontinue               stop  

enclosed herein         enclosed  

for the purpose of      for  

in order to                 to  
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in the course of         during  

in the event of           if  

in the near future       soon  

it has been brought to our attention     we have learned  

this point in time        now 

 

Add a sucker punch to your writing  
 

One good way to really wake up your reader, no matter how dry the topic of your 
document, is to very occasionally drop a paragraph consisting of a single sentence 
between two larger bodies of text. It can provide a dramatic jolt and create a 
quick, laser-like focus on the topic of that sentence. 

 

 Use a Focus Sheet for a better writer’s 
checklist 

 

Whether penning an e-mail update for your manager, an all-staff memo or a letter 
of complaint to a vendor, you are striking up a relationship. 

For your message to come across well, it helps to consider both sides of the 
relationship: What exactly do you want out of it, and how will the other person 
likely respond? 

“The more you consider your reader, the better your chances of getting the 
response you desire,” says Deborah Dumaine, author of Write to the Top. 

Dumaine recommends that before you write, plan your document by running 
through the questions on this Focus Sheet:  
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1. Purpose 
__    Why am I writing this? 
__    What do I want the reader to do? 

2. Audience 
__    Who exactly is my reader? 
__    What does the reader know about the subject? 
__    How will the reader react to my main message: Receptive? Indifferent? 
Resistant? 
__    What’s in it for the reader? 

3. Bottom Line 
__    If the reader were to forget everything else, what one main message do I want 
him or her to remember? 
__    So what? What is the impact of my bottom line? 

4. Strategy 
__    Should my message be a document? Or would a phone call be more effective? 
__    Timing: Am I too early? Or too late to send it at all? 
__    Distribution list: Is it trimmed to the minimum? 
__    Is someone else communicating the same information? Should I check? 

Now let’s take a closer look at each of the sections. 

Purpose: Some typical reasons for writing are to persuade, to request, to 
propose, to motivate, to explain or to respond. You’ll notice that “to inform” didn’t 
make the cut. That’s because most of your writing is actually meant to do 
something besides inform. 

Example: Are you writing to inform your manager about your progress on project 
ABC? Maybe. But your primary purpose may actually be to flaunt your 
capabilities. 
 
Audience: Nailing down who your audience is should determine how technical 
you can be, and whether you should soft-pedal or be assertive in making a 
request. 

Bottom line: “The sooner you can boil it down to one or two sentences, the easier 
it will be to write,” Dumaine says. 

Example: If you’re announcing that you’re holding a meeting, the bottom line is 
probably not, “I’m holding a meeting.” It’s more likely, “This meeting is critical 
right now because ___.” 



Strategy: Timing is very important. So much communication is wasted energy, 
because it arrives too late for action. And trimming your distribution list ensures 
your message gets read; people begin ignoring messages if they’re cc’d 
indiscriminately.  

Will you complete the Focus Sheet every time you dash off an e-mail? Probably 
not. But go through the exercise a few times to train your brain. It keeps your 
writing on track. 

 

 MS Word tip: Formatting 
disagreement 

 

Ever receive content so you can “make it pretty” or “clean it up?” What you 
received may be a heavily, but not necessarily coherently, formatted document. 
Here are two tips. If Styles have been used and just haphazardly changed, select 
everything (Ctrl+A), then press Ctrl+Spacebar. This returns everything to the 
default formatting for that style. A more “scorched earth” approach is to use the 
Clear Formatting button on the Home tab. This sets it all to Normal style. From 
here, you can start over with Styles. 

 

 Make your writing more assertive  
 

Sometimes we lose sight of the fact that assertiveness is not limited to situations 
where we communicate face-to-face. Come across with greater confidence by: 

Using energetic, engaging language. Your emails and notes are competing with 
everyone else’s, so you need “attention grabbers”—just as much as any 
professional writer does. When you’re trying to make an important point, don’t be 
afraid to spice up your verbs and adjectives, create paragraph breaks for effect or 
lead off with a bold statement. Bullet-point anything that might come across as a 
list and choose both your greeting and end salutation carefully. 
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Use your tech tools to highlight key passages. Underline the things you want to 
stress, precede them with an arrow or other interesting graphics, or set them in a 
different or larger font than the rest of your text. 

Have a well-organized presentation of ideas. State your main point up front, 
followed by supporting data or ideas. Your document will read smoothly and you 
won’t force readers to go through intellectual aerobics to get your message. 

Trim the fat. Use as few words as possible. The shorter the message, the more 
powerful. Call it the “Gettysburg Address” rule. 

Make concrete suggestions for improvement and progress. Ask yourself, 
What did I solve in this email? If you’re making a suggestion, pretend like it’s the 
only viable option and defend it well. Try to position your email as the last word 
on the subject. State clearly what steps should be taken and what deadlines 
should be put in place. 

Don’t dilute your original message. You should avoid using the word “basically” 
as a crutch. If something is a fact, state it as such. If something is your opinion, a 
simple “I feel” or “I am convinced” will be more effective in expressing your 
emotions than a long, flowery phrase. 

 

 Essential skills for big documents  
 

Most large documents are fragile and unwieldy because they have no bones. Wait! 
Weren’t we talking about documents? What we mean is that by using certain 
structural elements, formatting can be durable with multiple contributors, easy to 
navigate and easy to read. Possibly the most important thing is the order in which 
you do things. 

The order 

1. Outline using Heading Styles for major topics and subtopics. 

2. Fill in the text content under each major topic and subtopic. 
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3. Insert any graphics or tables needed, positioned roughly (not exactly) where 
you want them. 

4. Turn on Track Changes (or rely on versions to track them automatically). 

5. Send around for revision and to obtain additional content from other 
contributors. 

6. Clear any undesirable formatting (Ctrl+Spacebar). 

7. Fine-tune graphic/table positioning. 

8. Apply captions, if they will be needed, to tables and graphics. 

9. Insert tables of contents and figures where needed. 

10. Adjust paragraph flow. 

11. Insert cover page. 

12. Insert section breaks, if needed. 

13. Unlink headers and/or footers between sections. 

14. Adjust header and footer information, such as page numbers, as needed. 

15. Update table of contents and figures before printing. 

Heading styles 

By applying styles, you give your document structure and make it easy to 
navigate. To see this work, turn on the Navigation Pane. On the View tab, in the 
Show group, check the Navigation Pane checkbox. Now, outline your document. 
For each major heading, apply Heading 1 style; and for subtopics, Heading 2, 
Heading 3 and so on. The structure will also begin to appear on the left in the 
Navigation pane. And it will stay that way even as you begin to fill in the text 
content and graphics. 

After revisions by other contributors, you may notice some “creativity” with 
formatting. If the Navigation Pane still shows the correct outline, all you need to 
do is select all the text and use the Ctrl+Spacebar shortcut to return all text to the 
original style formatting. If necessary, reapply heading styles where they have 



been removed. Detect changes by comparing versions or navigating changes 
through the Track Changes feature. 

References 

After you have positioned your graphics and tables more precisely, you may have 
decided to create captions and/or a table of figures. On the References tab, with a 
graphic selected, choose Insert Caption from the Captions group. You’ll be shown 
a dialog box that will give you some choices as to how those captions will be 
numbered and formatted. Even if you insert additional graphics, by using this 
tool, numbering will be adjusted to keep it sequential. Depending upon the 
requirements of your deliverable, you may insert a table of figures either at the 
beginning or end of the document. In that same Captions group, use the Insert 
Table of Figures button to put it where it belongs. On the left of the References 
ribbon, you’ll also notice the Table of Contents button. Place this in the beginning 
of the document. 

 

 

 Whoa, whoa … easy on those commas!  
 

Commas are intended to help the reader comprehend a sentence more easily. 
Unnecessary ones are a distraction. Here are three places not to put a comma, 
from Barron’s Essentials of English: 

1. Do not interrupt the normal flow of thought with a comma. 

Faulty: The fact that the train had broken down halfway between its point of 
departure and its destination, was sufficient reason for the passengers to malign 
the railroad on social media. (Though the subject is a long clause, it is entirely 
clear. It opens the sentence as expected, and it is followed immediately by the 
verb. Inserting a comma after destination merely impedes the flow of thought.) 

Faulty: The carpenter insisted, that he knew what he was doing. (The comma 
after insisted separates the verb from its object.) 

Faulty: He drove a hard, sharp, painful, bargain. (The comma after painful 
separates the adjective painful from the word it modifies.) 
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2. Do not separate words or phrases joined by and or or. 

Faulty: He went to the office, and opened his mail. (And joins the compound verb 
went and opened. It does not join two clauses.) 

3. Do not place a comma between a conjunction and the word or words it 
introduces. 

Faulty: He was tired but, he refused to stop driving. 

Faulty: The little girl continued to hope that, her lost cat would soon be found. 
 
 
 

 A little slang can pep up almost 
anything  

 

You wouldn’t want to use it as a style guide, or for almost any business-to-
business correspondence, but getting familiar with some of the lingo found in the 
Urban Dictionary can help you add some modern flair to a routine document or 
presentation. Dropping terms like “phoneslinger,” “hate hug,” or “textretary” can 
be a real (and perhaps educational) wake-up. 
 
 

5 tips to make your e-newsletter 
speak loud and proud  

  

“With statistics like these, how are you going to compel people to read your 
newsletter?” 
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The daunting numbers Julie Perrine of All Things Admin spoke of in her April 
webinar are these: The average email user spends 51 seconds reading each e-
letter they get; that is, if that person is even among the 15 to 30 percent who open 
them. And yet e-letters are simply too valuable a business tool to do without, a 
thrifty touchpoint with your audience that can provide you with as much 
information as it offers them.  

Julie packed her session with tip after tip for fashioning messages that generate 
more and more readers. One theme she kept coming back to says a lot about 
where technology is today compared to just a few years ago—and why you need 
to shift your e-letter strategy right now or watch your open rates decline fast. 

Here are five techniques to keep in mind when launching an electronic ‘zine to 
grab them by the lapels and bring in their business (or just their undivided 
attention). They apply whether you’re blasting to 50,000 people or just that 
strange department on the floor beneath you: 

1. Bow down to mobile. It’s still a mental readjustment for most to imagine that 
their e-letters are so often being read on cellphones. Make that adjustment right 
now, Julie advised, and design for it. Go with a single column format when you 
can, and consider loading as much of your content as possible into the body of the 
e-letter itself—without demanding lots of link-clicking that challenges spotty cell 
reception and data plans. And make sure to test your email on as many devices as 
possible to note how it displays on each. “30 percent of people who have a bad 
mobile experience go to a competitor’s website,” Julie revealed. 

A subtle but key tech hint to consider is what text will first appear in a user’s 
inbox, especially on those mobile devices. Make the very first line below your 
masthead or banner something intriguing rather than having their message 
preview display something like today’s date or “Can’t read this email? Click here 
to view it on the Web.” 

2. Pick a frequency and do not slip. The goal is to create expectation and 
anticipation so that Monday afternoons always mean a little bonus in their inbox, 
or the first of the month brings them good news. Random blasts erode the 
audience’s confidence in you, as do delays in getting them what they’ve come to 
expect. 

3. Test subject lines out on … you. Ask yourself, “Would I open this?” Trotting 
out the same subject line every month or getting too conservative puts you at the 
mercy of all the other emails bombarding your subscribers’ inboxes. Pose a 
question, create a mystery, issue a command. The subject line’s length is never 
quite as important as its content, but a soft limit of 50 characters is good to shoot 



for. Be careful not to make those characters spell out words that ever-evolving 
spam filters watch for. 

4. Get personal. You’ve sent them a pretty email, but they may be thinking, “Who 
are these people?” Your e-letter can speak as some company going through the 
motions of the communications race, or it can possess the voice of a real human 
being taking a genuine interest in the recipient. “Break through the façade and 
offer a face,” Julie advised; her own e-letter begins with a note directly from her 
every time. 

5. Remember to heal their pain. “Pain points,” that is. When an attendee asked 
during the Q & A session how to sell a product in an e-letter without coming off 
too aggressively, Julie reminded us that as long as each issue directly addresses 
readers’ daily struggles and provides a real, free solution or two, they’ll take a 
post-wisdom sales pitch in stride. 

Is it even realistic to forgo these digital shouts if the means to make them is so 
prevalent and available? It doesn’t seem so when you consider the benefits. 
Keeping an open line between you and those you need to reach is mandatory in 
this era of social media and readers who crave giving instant feedback. And even a 
basic level of service (Mail Chimp and Constant Contact were just two of the 
providers Julie mentioned) will give you those most magical tools: open and click 
rates. They’ll tell you which content users are reading, which subject lines are 
working, where their eyes are going. Print can’t deliver those metrics. 

If you’re at all on the fence about whether you want to produce an e-letter, 
consider one last benefit Julie mentioned: your personal return on investment. 
Getting an e-letter up and running is like putting an assortment of work skills into 
a blender and making yourself a healthy résumé shake. You’ll learn intensely 
about writing, editing, marketing, HTML, design, list-building, email collection and 
even the laws that protect us from spam. So go ahead and be a little selfish with 
your plan to start creating … as long as you remember to test all your links before 
clicking Send. 

 

 

 

 



 Creating bookmarks in Word  
 

Microsoft Word has the ability to create bookmarks (essentially metatags) with 
any selection of text or objects. This really comes in handy when you have a 
citation in mind, but not the citation data yet. For example if you want to quote 
Stephen Covey and know the quote, but not the reference, you can create a 
bookmark and navigate to it later. Once your text is selected, click the Bookmark 
button (Insert tab, Links group). Give it a name and click Add. Now, from the Go 
To dialog (Ctrl+G), you will be able to conveniently locate any bookmarked text 
that you created. 

 

 Make electronic thank-yous 
memorable  

 

Sending an electronic thank-you note is never quite as classy as a paper note or 
card, but there’s one way to make your gratitude stand out: Create a memorable 
subject line that’ll pop up impressively in their inbox. Instead of just “Thank you 
for your gift” or “We appreciate you going the extra mile,” which sound computer-
generated, try something like “Wow, did we dream that project or did you actually 
make it happen?” or “Help, we can’t stop telling our friends about what was in 
that box!” 
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 Clean up your sentences with 
parallelism  

 

Parallelism is the care given to balance words with other words to make yourself 
clear. For example, items in a list should be parallel. Check out this list, and spot 
the problem: 

The steps of making a movie are: 

 Write a script. 
 Finding a producer. 
 To hire a director. 
 Getting funding. 
 Roll cameras! 

The verbs in this list are all over the place, making the list jarring. Applying 
parallelism makes the list read more smoothly: 

 Write a script. 
 Find a producer. 
 Hire a director. 
 Get funding. 
 Roll cameras! 

Or how about this sentence: 

You seem to have more interest in the Coldplay concert than raking the yard. 

Applying parallelism, we get this improved version: 

You seem to have more interest in going to the Coldplay concert than in raking the 
yard. 

One more example: 

You can impress your boss by saving the company money or dedication to 
excellence. 

Better: 
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You can impress your boss by saving the company money or dedicating yourself to 
excellence. 

Notice how parallelism brings consistent grammatical construction to each part of 
these sentences, making them friendlier to the ear. 
 

 

 Did you know that Word can translate 
your documents for you?  

 

If you receive a document in another language, on the Review tab in the Language 
group, look for the Translate button. You can either choose Translate Document 
or Translate Selection. The Translator task pane will appear on the right and 
allows you to choose a From language and a To language. It will also translate in 
real time while you type if you keep the pane open. Use the Translator only for 
better understanding. To produce a translation that supports a legal agreement, 
always use a professional translator. 
 
 

 The war against capital letters  
 

The internet predictably lost its mind recently when it was revealed that lecturers 
at Leeds Trinity University had been cautioned not to overuse capital letters 
when issuing assignments. Students were sometimes intimidated by all-caps 
messages, the university claimed, as they were when they encountered the word 
‘don’t’ and other negative terms. 

“Despite our best attempts to explain assessment tasks, any lack of clarity can 
generate anxiety and even discourage students from attempting the assessment 
at all,” a memo said. 

https://cms.businessmanagementdaily.com/?p=355746
https://cms.businessmanagementdaily.com/?p=355746
https://cms.businessmanagementdaily.com/?p=346100


The university said its guidance was based on research into best practices in 
teaching. 

Professor Margaret A House OBE, vice-chancellor at Leeds Trinity University, told 
Mirror Online that “it is also about good communication and consistent style. For 
example, it is best practice not to write in all capital letters regardless of the 
sector.” 

While some have perceived the university’s guidance as a weak concession to the 
overly sensitive, there’s likely some good communication advice in it: 

1. Drop all-caps in your emails and office signs. Even those who shrug off the 
aggressive use of all-caps often perceive it as clunky and a little obnoxious. 

2. Frame instructions positively. A list of don’ts comes off as hostile and 
ungrateful. Try a gentler way to get people to comply. 
 
 

 MS Word tip: Changing styles easily 
 

If you’ve ever lived through a branding change, you know the heartache of having 
to change pages and pages of content to reflect new colors and fonts. If you use 
Styles, this change is a breeze. Simply change one occurrence of the style—for 
example, a Heading 1. Then, on the Home tab in the Styles gallery, locate the style 
and right-click the tile. Then choose Update <style name> to match the selection. 
Every occurrence of that style will now reflect your new fonts and colors. 
 
 
 

 5 tips for writing ‘power’ headlines  
 

 
 
Whether you’re writing a report, a presentation or a newsletter story, your 
headlines can make or break your document. Here’s how to remedy even the 
worst headlines: 
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1. Be specific. Replace a broad headline with a concrete one. 
   Broad: “Background information” 
   Better: “Our role in the wireless revolution” 
 
2. Include your point. Give more information, not less. 
   Broad: “Improvements” 
   Better: “Recommendation: ways to improve employee training” 
 
3. Emphasize action with verbs in the active voice.  
   Broad: “Step 1” 
   Better: “Hold a kickoff meeting” 
 
4. Be positive. People are drawn to good news. 
   Negative: “Problem: absenteeism in the workplace” 
   Better: “Opportunity: Increase productivity by reducing absenteeism” 
 
5. Ask questions that will appeal to your readers. 
   Broad: “Timetable” 
   Better: “When can you expect the results?” 
 
—Adapted from Write to the Top: Writing for Corporate Success, Deborah Dumaine, Random 
House. 

 


